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iISoftPhone 1.4 and pbxes.com x

1. Introduction

These Application Notes describe the configuration steps for using the
iISoftPhone 1.4 (build level 1.4040-070912 or higher) with pbxes.com iPPABX.
General administration information can be found in the product documentation.
Products WEB sites:

e SoftPhone — http://www.call4mac.com

e pbxes.com — http://pbxes.com

2. Configuration

The configuration used in the test is shown at the picture below.

iSoftPhone 1.4

iSoftPhone 1.4

pbxes_org
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3. Equipment and Software

The following equipment and software were used in the configuration.

EQUIPMENT SOFTWARE
X-Lite 3.0
PC Win XP Pro SP2
iISoftPhone 1.4 (build 1.4040-070912)
Apple Macintosh MacOS X 10.4.9
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iISoftPhone 1.4 and pbxes.com

4. Creating a new internal VolP subscriber

When you log in to your pbxes.com account, the configuration interface appears.

a p - b - % es :: your virtual PBX and CRM on demand - Microsoft Internet Explorer & il
File Edit View Favorites Tools Help ‘ :,'
. - m . =
s h) J . .. 3 kL - £ ﬁ
G Back = () |ﬂ @ _,lj ‘ P Search ) Favorites {} = 3] ig ¥
Address I@ https: ) fwwwil,pbies, comjconfig, php j Go ‘ Links **
= i ippbu01  LOGOUT 5
T VOUR FERSOMAL FHONEEOXES COMMUNITY SETUP SHOP 3> GRERTE ¥ OUR AGCOUMT
*Home » Setup » News
» Setup PBXes 09/02/2007
Handoff between WLAN/GSM
» Entension netwarks
i & 07/27/2007
» Ring Grou Prouider recommendation for
This area of the website allows you to configure your FBX, business
D TS 06/07/2007
» Incoming Calls Full G.729 support
05/017/2007
» Inbound Routing PBRes PRO -~ Multichannel
. Customer Interaction
» Dutbound Routing 022572007
» 0On Hold Music Cheilengusge s
» System Recordings ptatistes
B Customers
» General Settings Accounts 12,501
» Personal Data G 17433
Catacenters
» Call Monitor Frankfurt 15.0%
Miirnberg 50.5%
» Status San Diego 8.2%
Mew Vark 10,2%
» Support Paris 15.7%
» Logout What our Clients say
i-p-tel.com work WERY hard
l— and wantto make a good —
product, That iz exactly the
3 reason I have contributed in
SoarEh FErmm the ways that [ have, These
quys not only read the forums
they reply!
Search Wiki » supernettel, Puerto Vallarea
PayPal
PREMIUM ACCOUNT | e )| [

‘@ https vl pbxes, comfconfig.php?display=extensions ’_ l_ ’_ ,@ ré_ & Internet
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iISoftPhone 1.4 and pbxes.com

Open ‘Extensions’ tab, click ‘Add Extension’ and then ‘SIP’.

our virtual PBX and CRM on demand

=18]x|

File Edit Wiew Favorites Toolks  Help

| &

eBack - -J - |ﬂ @ _h | /__j Search “gl'.(FavUrites {:‘3‘ [

Address I@ https: ) {0, pbxes .comfconfig. php?display=extensions

— YOUR PERSOMAL FHONEEOXES COMMUNITY SETUP SHOP

»Home » Setup » Extensions

Setup PBXes

Extensions

* Add Extension
Select device technology:

Ring Groups

Trunks
Incoming Calls [%
Inbound Routing

Outbound Routing

On Hold Music

System Recordings

General Settings

Personal Data

Call Monitor

Status

Support

Logout

—

Search Forum »

—

Search Wiki »

B> |Links =

ippbu0l  LOGOUT »

3 GREATE 7 OUR ACGOUNT

News

09/02/2007

Handoff between WLAN/GSM
netwarks

07/27/2007

Pravider recornmendatian far
business

08/07/2007

Full 5,722 support
05/01/2007

PBHes PRO -- Multichannel
Customer Interaction

02/25/2007

Other languages
Statistics

Customers

Accounts 12,501
Phones 17,433
Datacenters

Frankfurt 15.0%
Miirnberg 50.3%
San Diego 8.2%
Mew Vork 10.8%
Paris 15.7%

What our Clients say

i-p-tel.com werk VERY hard
and want to make a good
product, Thatis exactly the
resson [ have contributed in
the ways that I have. These
guys not only read the forums
they reply!

supernettel, Puerta Vallarta

PayPal

DOHATE

=l

& RN T
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iISoftPhone 1.4 and pbxes.com

Enter unique extension number and password. Optionally you can enter display

name.

p - b - % es = your virtual PBX and CRM on demand - Microsoft Internet Explorer == ﬂ

File Edit Wiew Favorites Toodls Help | :;'

@Back - d e |ﬂ @ hh|/.__jSearch ‘_»i\‘L_(Favor\tes {‘3| = :\F .ﬂ - _J ﬁ ﬁ

Address I@ hittps ) o). phixes. comf config. php?display=extensionsidt ech=sipfskip=0

j Go |L|nks »

Setup PBXes

Extensions
*» Add Extension

Ring Groups

Trunks

Incoming Calls

Inbound Routing
Outbound Routing
On Hold Music

System Recordings

General Settings

Personal Data

Call Monitor

Status

Support

Logout

l— password

»Home » Setup » Extensions

Add Extension

Extension Mumber: I3333
Display Mame: IJUhn

Extension Options

Cuthound CID: I

Device Options

Imypasswnrtﬂ

Search Forum » language Ieng\ish i~

Search Wiki » voicemail & Directory: IDlsabIed 'I

PREMIUM ACCOUNT

ORDER NOW »
MORE DETAILS » Submn[

News

03/02/2007

Handoff between WLAN/GSM
networks

07/27/2007

Provider recommendation for
busineszs

0&/07/2007

Full G.72% suppart
05/01/2007

PBies PRC -- Multichannel
Customer Interaction

02/25/2007

Other languages
Statistics

Custamers

Accounts 12,528
Phanes 17.425
Datacenters

Frankfurt 15.1%
Miirnberg 50.2%
San Diego 2.2%
Mew ark 10.8%
Paris 15.7%

What our Clients say

i-p-tel.com work VERY hard
and wantto make a good
product, Thatis exactly the
reazon I have contributed in
the ways that [ have, These
quys not only read the farums
thay reply!

supernettal, Puerto Vallarta

PayPal

DONATE

|
el

Submit the changes.

=]

=l

Y Y —
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iISoftPhone 1.4 and pbxes.com

New account (John <1111>) appears in ‘Extensions’ tab. To apply the changes press

the red bar.

b -k es  your

File Edit Wiew Favorites Tools Help

ual PBX and CRM on demand -

osoft Internet Explorer

18]

| &

@Back - d e |ﬂ @ hh|/.__jSearch ‘_»i\‘L_(Favor\tes {‘3| = :\F .ﬂ - _J ﬁ ﬁ

Address I@ hittps ) o). phixes. comf config. php?display=extensionsidt ech=sipfskip=0

j Go |L|nks »

Setup PBXes

Extensions
> Add Exntension
» John <3333>

Ring Groups

Trunks

Incoming Calls

Inbound Routing
Outbound Routing
0On Hold Music

System Recordings

General Settings

Personal Data

Call Monitor

Status

Support

Logout

——

Search Forum »

——

Search Wiki »

PREMIUM ACCOUNT

ORDER NOW »
MORE DETAILS »

»Home » Setup » Extensions

You have made changes - when shed, click here to APPLY them

Add Extension

Extension Murnber: I

Extension Options

Display Mame:

Qutbound CID:

—

Device Options

password I
language Ienghsh 52

IDisabIed 'I

Yoicemail & Directory:

Submit

/02/2007
Handoff between WLAN/GSM
networks

07/27/2007

Provider recommendation for
business

08/07/2007

Full 6,723 suppart
05/01/2007

FEXes PRO -- Multichannel
Cugtorner Interaction

02/25/2007

Other languages
Statistics

Customers

Accounts 12.528
Phones 17.485
Datacenters

Frankfurt 15.1%
Miirnberg 50.2%
San Diegn 5.2%
Mew York 10.8%
Paris 15.7%

What our Clients say

i-p-telcom work VERY hard
and want to make a good
product, That iz exactly the
reason I have contributed in
the ways that [ have, These
quys not only read the forums
they reply!

supernettel, Puerto Vallarta

PayPal

=]

=l

Y Y —
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iISoftPhone 1.4 and pbxes.com

If you want to change the settings of an existing account, simply click this account in

‘Extensions’ tab.

p * b - % es :: your virtual PBX and CRM on demand - Microsoft Internet Explorer =7 5[
File Edit Wiew Favorites  Tools  Help | -:,’
= " = n g =
- &Y - ] -'r i Z e - iﬂ ot
@ Back. d lﬂ @ _ﬁ ‘ e Search ‘?/\( Favorites {3 =" .ﬂ _i
Address I@ hittps: i, pbxes, comfconfig.phprdisplay=extensionsiclk_reload=true d G0 | Links >
-
» Home » Setup » Extensions Wieao
¥ Setup PBXes 0%/02/2007
Handoff between WLAN/GSM
» Extensions networks
: 07/27/2007
* Add Extension Provider recommendation for
Select device technology: business
i % 06/07/2007
» Ring Groups Full G.729 support
. 05/017/2007
» Trunks PRXes PR -- Multichannel
. . Customer Interaction
» Incoming Calls 02/25/2007
» Inbound Routing Other languages
» Outbound Routing pratistcs
_ Custamers
» On Hold Music Accounts 12528
A Phones 17.485
» System Recordings Datacenters
» General Settings Frankfurt 15.1%
Miirnberg 50.2%
» Personal Data San Diegn 2.2%
. Mew Vork 10.8%
» Call Monitor Paris 15.7%
» Status What our Clients say
» Support i-p-tel.corm work WERY hard
and want to make a good
# Logout product, That is exactly the

reason I have contributed in
the ways that T have, These

guys not only read the forums

they reply!
Search Forum »

I
PayPal

Search Wiki = DONATE

supernettel, Puerte Vallarta

PREMIUM ACCOUNT

ORDER NOW »
MORE DETAILS »

=
|@ https: |} fwwwl, pbxes, comjconfig, phprdisplay=extensionséskip=0&extdisplay=3333 l_ ’_ ’_ l_ ’—é_ & Internst
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iISoftPhone 1.4 and pbxes.com

File Edit Wiew Faworites Tools  Help

es :: your virtual PBX and CRM on demand - Microsoft Internet Explorer

=l

| i

@Eack - J - |ﬂ @ ¥h ‘ /’:] Search ‘ir\\'{Favoritas ﬁ)‘

ew- )il

Address I@ https: il phixes .comjconfig. php?display=extensionstskip=0fextdisplay=3333

j GD |L|nks =

Setup PBXes

Extensions
* Add Extension
* John <3333>

Ring Groups

Trunks

Incoming Calls

Inbound Routing

Outbound Routing

On Hold Music

System Recordings

General Settings

Personal Data

Ccall Monitor

Status

Support

Logout

——

Search Forum »

——

Search Wiki »

PREMIUM ACCOUNT

ORDER NOW »
MORE DETAILS »

» Home » Setup » Extensions

Edit Extension

Display Marne: IJDhn

Extension Options

Qutbound CID: I

Device Options

password Imypasswurd
language Ieng|i5h hd
dtrnfrode Iauto 'l

audio bypass ho o+

dial [EPippbxni-3333

Mobile Options

mobile no ¥

[=|

News

0%/02/2007

Handoff between WLAN/GSM
networks

07/27/2007

Provider recommendatian for
business

0&/07/2007

Full 729 support
05/017/2007

PRXes PR -- Multichannel
Customer Interaction

02/25/2007

Other languages
Statistics

Custamers

Accaunts 12,528
Phones 17.485
Datacenters

Frankfurt 15.1%
HMiirnberg 50.2%
San Diego 2.2%
Mew York 10.5%
Paris 15.7%

What our Clients say

i-p-tel.com work WERY hard
and want to make a good
product, That is esactly the
reason I have contributed in
the ways that T have, These
guys not only read the forums
they reply!

supernettel, Puerte Vallarta

PayPal

DONATE

|@ Done

File Edit View Favortes Tools Help

es :: your virtual PBX and CRM on demand - Microsoft Internet Explorer

=l

Y Y —

=l

| [Z

eﬁack - \) - |ﬂ @ xh ‘ ;j Search ‘{:{Favorltes {‘3‘ [_\:v :\; ] - _J ﬁ

Address I@ hittps: }fwwnnl, pbxes, comjconfig, phprdisplay=extensionséskip=0&extdisplay=3333

I Ee |Linls »

» Inbound Routing
» Outbound Routing

» On Hold Music

System Recordings

General Settings

Personal Data

Call Monitor

Status

Support

Logout

——

Search Forum »

——

Search Wiki »

PREMIUM ACCOUNT

ORDER NOW »
MORE DETAILS »

GET YOUR P-E-Xf5pmo

ORDER NOW »
MORE DETAILS »

Display Name: IJDhn

Extension Options

Outbound CI0: I

Device Options

password W
language Im

dtrnfrnode m

audio bypass m

dial IW

Mobile Options

rmobile nox

Voicemail & Directory: IDi53b|Bd B

Subrit

Ther lanquages =]

Gtatistics

Custamers

Accounts 12,528
Phones 17,485
Datacenters

Frankfurt 15.1%
Hiirnberg 50.2%
San Diage 2.2%
Mew ¥ork 10.2%
Paris 15.7%

¥What our Clients say

i-p-tel.com work VERY hard
and want to make a good
product, That iz exnactly the
reason I have contributed in
the ways that I have, These
guys not only read the forums
they reply!

supernettel, Puerte Vallarta

Pa,
DONATE

|@ Done

=

I =Y =
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iISoftPhone 1.4 and pbxes.com x

5. Configuration on iSoftPhone 1.4

Once iSoftPhone 1.4 is installed then SIP server settings must be configured.
5.1 Configuring SIP server account

To configure SIP server account please press the icon E from the bottom

toolbar of iSoftPhone.

iSoftPhone ™

Neo server settings.
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iISoftPhone 1.4 and pbxes.com

5.2 Preferences “Register/Credits”

tab.

In the new appeared “Preferences” window please select “My SIP accounts”

Preferences

r_ Register/Credits | My SIP accounts | Interface

Provider: ISIF-‘phcme T!

f*) Create new SIPphone account

J

()

)

If you don't have am account and you want to creata ane on
SIFphone server.

Buy a credit for my SIPphone account

If you have an account om SIPp-hone server and you want o
charge It

Configure iSoftPhone for my existing SIP account

If you have an account om other senver and yow want to
configure iSoftPhone to wse it

Find my friend on S5IPphone

Search SIFphone for any person

| Cancel | | MNext
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iISoftPhone 1.4 and pbxes.com

5.3 Preferences “My SIP accounts”

The empty “My SIP accounts” tab was shown below.

Preferences

Register/Credits My SIP accounts Other

__ No defined accounts A |Z||:|

Server address:

Username:

Password: | Show |

Display name:

Authorization name:

Enabled: _

Audio codec

Choose Automatically = Automatic choice
PCMU
PCMA The codec will be negotiated with
GSM a SIP server.
G726-32
iLBC _

Connection settings

Listen RTP port:

STUN server:

Outbound proxy:

| Cancel | | OK
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iISoftPhone 1.4 and pbxes.com

n e T

To configure SIP account that was created on pbxes.com iPPABX please

con 5 o
press the icon and fill up parameters as was shown below.

Preferences

Register /Credits = My 5IP accounts ~ Other

%, ippbx01-3333@pbxes.org = ==
Server address: pbxes.org
Username: ippbx01-3333
Password: ssessassss | Show

Display name:

Authorization name: ippbx01-3333
Enabled: ¥

Audio codec

Choose Automatically Automatic choice

PCMU
PCMA
GSM
G726-32
iLBC

The codec will be negotiated with
a SIP server.

CC 0 0 e

Connection settings

Listen RTP port:

STUN server:

Qutbound proxy:

Cancel | | OK

Server address: pbxes.org
Username/Authorization name: <your pbxes.com account name>-<extension>
Password: password for this pbxes.com SIP extension (see chapter 4)

After all please confirm settings by pressing “OK” button.
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iISoftPhone 1.4 and pbxes.com x

5.4 Registration on SIP server account

Once SIP account settings were configured then iSoftPhone will try to connect

and register on pbxes.com iPPABX. The process was shown below.

iSoftPhone ®

Cornecting...

When all parameters were configured properly and iSoftPhone successfully

registered on pbxes.com iPPABX then application window will look as shown below.
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iISoftPhone 1.4 and pbxes.com

iSoftPhone ©

1 Attached to <ippbx01-3333>

Congratulations! You have successfully configured iSoftPhone with pbxes.com
iPPABX.
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6. Configuration of the SIP account at SIP Provider (for external calls)

6.1 Creating a new SIP Trunk

To add a new trunk, simply open the ‘Trunks’ tab, select ‘Add Trunk’ and then ‘Add
SIP Trunk'.

3 2 p - b - x es  your virtual PBX and CRM on demand - Microsoft Internet Explorer ;Iilil
Fle Edit ¥iew Favortes Tools Help | :,'
= . - N 5 5
0 Back - "J - \ﬂ lELI _ﬁ ‘ /_j Search \&:( Favorites {_‘3 | A (=] ﬁl - ﬁ ﬁ
Address I@ htkps: j v, phixes. comfconfig.php j o ‘ Links *
-

ippbuDl  LOGOUT »

— ¥OUR FERSONAL FHONEBOXES COMMUNITY SETUP SHOP > GREATE YOUR ACCOUNT
* Home » Setup @ News
» Setup PBXes 0%/02/Z007
Handoff between WLAMN/GSM
» Exntensions netwarks
. 0¥/2v/z007
» Ring Groups Provider recommendation for
This area of the website allows you to configure your PEX, business
» % 06/07/2007
» Incombg Calls Full G, 729 support
05/01/2007
» Inbound Routing PBXes PRO -- Multichannel
- Customer [nteraction
» Outbound Routing 0z/25/2007
» On Hold Music Otherllangueges
» System Recordings Statistcs
_ Custamers
» General Settings Accounts 12501
» Personal Data Gl 17433
Datacenters
» Call Monitor Frankfurt 15.0%
Miirnberg S0,3%
» Status San Diego 8.2%
Hew York 10.8%
» Support Patiz 15.7%
» Logout What our Clients say

i-p-tel.com work WERY hard

l— and wantto make a good -
product, That is exactly the

reason [ have contributed in

the ways that I have, These
quys not only read the forums

they reply!

Search Wiki » suparnattal, Puerts Vallarta

Search Forum »

PayPal
PREMIUM ACCOUNT | ]
|@ https: [ w0, pbxes.comjconfig. php?display=6 ’7 ’7 ’7 ’7 ’—g & Internet

Page 17



iISoftPhone 1.4 and pbxes.com

File Edit view Favorites Tools Help

irtual PBX and CRM on demand - Microsoft Internet Explorer

=8|
| [z

eBack - L) ™ \ﬂ @ ;;j ‘ /__j Search ‘i}(FavUntes £‘ZI| [_:v :__\', .9_"] - _J ﬁ &

Address I@ https:{jwnnl . pheces. comfconfig. php?display=6

— YOUR PERSONAL FHOMEBOXES COMMUNITY

» Home » Setup > Trunks

» Setup PBXes
» Exntensions
» Ring Groups
» Trunks
»> Add Trunk
» Incoming Calls {b
» Inbound Routing
» Dutbound Routing
» 0On Hold Music
» System Recordings
» General Settings
» Personal Data
» Call Monitor
» Status
» Support

» Logout

—

Search Forum »

—

Search wWiki »

SETUP

SHOP

|@ https: w0, pbxzes.comjconfig. php?display=6etech=5IP

j Gn ‘Llnks >
-

ippbuDl  LOGOUT »

3> GREATE ¥OUR AGGOUNT

News

09/02/2007

Handoff between WLAMN/GSM
networks

0¥/2v/z007

Provider recommendation for
business

06/07/2007

Full G, 729 support
05/01/2007

PBXes PRO -- Multichannel
Custamer Interaction

0z/25/2007

Other languages
Statistics

Customers

Accounts 12,501
Phones 17.433
Datacenters

Frankfurt 15.0%
Miirnberg S0,3%
San Diego 5.2%
Mew Yark 10.8%
Paris 15.7%

What our Clients say

i-p-tel.com work WERY hard 1=
and wantto rmake a geod
product, That is exactly the
reason [ have contributed in
the ways that I have, These
quys not only read the forums
they reply!

supetnettel, Puerto Wallarta

PayPal
sonate || |

[T B
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iISoftPhone 1.4 and pbxes.com

Enter a name for this trunk.
In the ‘Account’ section enter username, password and SIP server address (you

receive this information from your SIP Provider).

: p * b % es : your virtual PBX and CRM on demand - Microsoft Internet Explorer =5 5[

File Edit Wiew Favoribes Tools  Help | :,'

eEack - J - |ﬂ @ _;j ‘ /._7] Search ‘:?:\L( Favorites {‘3‘ TR L_F .ﬂ - _J ﬁ ﬁ

Address I@ https: [, pbces . comfconfig. phpidisplay=6ékech=5IF

| Ee |Links =

=l

+ Home » Setup » Trunks Hieme
» Setup PBXes 09/02/2007
Handoff between WLAN/GSM
*» Exrtensions networks
. 07/27/2007
» Ring Groups Provider recommendation for
H business
» Trunks General Settings S
» Add Trunk Full 5.725 support
05/01/2007
» Incoming Calls Trunk Mare: Ivoipd\scoum PBHes PR -- Multichannel

Customer Interaction

language: Ienglish > 02/25/2007

Other languages

Outbound Routing
dtmfrnode: IauIU i Statistics

On Hold Music
audio bypass: I vI Customers
22 L Accounts 12.501

Inbound Routing

System Recordings

» General Settings ;:g:::mars 17.433
» Personal Data Account Frankfurt 15.0%
Miitnberg 50,3%
» Call Monitor San Diego B2%
Mew York 10.8%
» Status username: Ipb D::s ot Loa
» Support password: Ipb" What our Clients say
» Logout i-p-tel.com work YERY hard

SIP server: Isip.vmpdiscount.cor
registar: Iyes (inbound and outhound calls)j

Search Forum »

——

Search Wiki » Maximum channels:

and want to make a good
product, Thatis exactly the
reason I have contributed in
the ways that I have, These
guys not only read the forums
they reply!

Optional Settings

supernettel, Puerto Yallarta

PayPal

DONATE

Maximurn outbound
channels:

PREMIUM ACCOUNT

ORDER NOW »
MORE DETAILS »

PT

Outbound Caller ID:

Dial Rules
[ ] =
=] [T 8 @ mtemet
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iISoftPhone 1.4 and pbxes.com

- ¥ es = your virtual PBX and CRM on demand - Microsolt Internet Explorer _ & x|

File Edit View Favorites Tools Help | :,'
= a ~ e = P
- - L - A -
e Back. u lﬂ @ _I] | P Search L‘./-\( Favarites {3 | =" I)_fl ’ia &
Address I@ https: . pbxes.comyconfig. phpdisplay=6&tech=5IF j G0 | Links
» General Settings [ — -
» Personal Data Account Frankifurt 15.0%
Miirnberg 50.3%

» Call Monitor San Diego 2.2

Mew York 10.5%

» Status CECTEEY nb Paris 15.7%
» Support password: nhy What our Clients say
» Logout - — i-p-tel.com work VERY hard

SIP server: sip.voipdiscount.car and want to make a good
product, That iz exactly the

reqgister: Iyes (inbound and outbound ca\ls)j reason I have contributed in

the ways that [ have, These
Search Forum » quys net only read the farums

Optional Settings WD

supernettel, Puerto Vallarta
Search wiki » Maxirnurn channels: PayPa.l']
Mazirnurn outbound l— DonRTE
channels:
PREMIUM ACCOUNT —
Cutbound Caller 1D:

ORDER NOW »
MORE DETAILS »

Dial Rules

GET YOUR ‘XESpPRO Dial Rules: =

ORDER NOW »
MORE DETAILS #

Clean & Remove duplicates || —

Dial rules wizards: |(pick one) j

Quthound Dial Prefix:

Submit Changes !
El

=] I E

Submit the changes.
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iISoftPhone 1.4 and pbxes.com

New trunk (SIP/voipdiscount) appears in ‘Trunks’ tab. To apply the changes press
the red bar.

our virtual PBX and CRM on demand osoft Internet Explorer =& 1[
File Edit View Favorites Tools Help | ﬂ'
™ A = e 3 3. 1 £
eBack > B |ﬂ @ _l] | /.\:'Search . Favorkes £‘B| = l)_}] - _J ﬂ &
Address I@ https: ) fwwwi, pbixes.camfconfig.php j Ga |Links 2
-

ippbx01  LDGOUT »

e TOUR FERSOMAL FHOMEEOMES COMMUNITY SETUP SHOP 3 CREATE Y OUR ACCOUNMT

Setup

» Setup PBXes /02/2007
[% Handoff betwean WLAMN/GSM
» Extensions networks
_ 07/27/2007
» Ring Groups Provider recammendation for
business
B AL S 06/07/2007
* Add Trunk WARNING: This trunk is not used by any routes! E;I}DGI';;DQDS?UPPDK
» SIPfuoipdiscount PBRes FRG -- Multichannel
R . Customer Interaction
» Incoming Calls General Settings 02/25/2007

» Inbound Routing Other languages

» Outbound Routing Trunk Marme: vnipdiscount Statistics

Customers

» 0On Hold Music A
language: - Accounts 12,501
g EngIISh Phones 17,433

» System Recordings

Dratacenters
dtrmfmode: auto i
» General Settings Frankfurt 15.0%
dio b ' lﬁ Miirnberg 50,3%
» Personal Data audio bypass: hoo San Diego S.2%
) Mew York 10.8%
» Call Monitor Paris 15.7%
» Status Account Wwhat our Clients say
» Support i-p-tel.icom work VERY hard
and want to make a good
» Logout username: pb

reason I have contributed in
password: phix the ways that I have, These

quys not only read the farums
SIP server: ip.woipdi they reply!
Search Forum » sip.voipdiscount. cor

supernettel, Puerto Vallarta
PayPal

Search wiki » Optional Settings DoNATE =l

@ TS e

product, That is exactly the

register: |3res (inbound and authound ca\ls)j
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* b - % es  your virtual PBX and CRM on demand - Microsoft Internet Explorer

File Edit view Favorites Tools Help

=181

| [z

eBack - ‘.J - \ﬂ @ _b ‘ /__j Search ‘in‘\'( Favorites {‘3| <]~ :ﬁ .J_".I b _J ﬁ ﬁ

Address I@ htkps: j vl phixes, comyconfig. php?display=6fuclk_reload=true

j Gn ‘Llnks >
-

T YOUR FERSONAL FHOMEBORES COMMUNITY SETUP

» Home » Setup > Trunks

» Setup PBXes
» Exntensions
» Ring Groups
» Trunks

»> Add Trunk

» S$IP /voipdiscount
» Incoming Calls
» Inbound Routing
» Dutbound Routing
» 0n Hold Music
» System Recordings
» General Settings
» Personal Data
» Call Monitor
» Status
» Support

» Logout

—

Search Forum

——

Search wiki »

SHOP

6.2 Adding a new outbound route

ippbuDl  LOGOUT »

3> GREATE ¥OUR AGGOUNT

News

09/02/2007

Handoff between WLAMN/GSM
networks

0¥/2v/z007

Provider recommendation for
business

06/07/2007

Full G, 729 support
05/01/2007

PBXes PRO -- Multichannel
Custamer Interaction
02/25/2007

Other languages
Statistics

Customers

Accounts 12,501
Phones 17.433
Datacenters

Frankfurt 15.0%
Miirnberg S0,3%
San Diego 5.2%
Mew Yark 10.8%
Paris 15.7%

What our Clients say

i-p-tel.com work WERY hard
and wantto rmake a geod
product, That is exactly the
reason [ have contributed in
the ways that I have, These
quys not only read the forums
they reply!

supetnettel, Puerto Wallarta

PayPal
sonate || |

[T B

Now you need to configure the outbound route that will be used for outgoing external

calls.
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Open ‘Outbound Routing’ tab and then ‘Add route’.

p - b -k es :: your virtual PBX and CRM on demand - Microsoft Internet Explorer = ﬂ
File Edit Vew Favortes Tools Help | :,'
Y A - . . z ! ¢
e Back - -d - Iﬂ Iﬂ kﬂ ‘ /- ) Search “ . Faverites ﬁ‘} ‘ [ = |)_’;| - ﬂ 4

Address I@ https:/fwewl, pbixes .comjcanfia.php j Go | Links **

I ippbu01  LOGOUT »

— ¥OUR PERSONAL PHONEEOXES COMMUNITY SETUP SHOP > GREATE ¥ OUR ACEOUNT
+ Horne » Setup » MNews
» Setup PBEXes 09/02/2007
Handoff between WLAN/GSM
» Extensions networks
B 07/27/2007
» Ring Groups Pravider recammendation far
This area of the website allows you to configure your PBX. business
P TS 0&/07/2007
» Incoming Calls Full 6,729 support
05/01/2007
» Inbound Routing PBHes PR -- Multichannel

Customer Interaction

# Outbound Routin 02/25/2007
» On Hold Musl(j\ j Other languages

- Statisti

» System Recordings atisties

R Customers
» General Settings Accounts 12,501
» Personal Data ;:i::zmars 17453
» Call Monitor ;rar\l;ﬂ.lrt égg:

iirmberg §
» Status San Diego 2.2%
Mew York 10.8%

#» Support Pariz 15.7%
» Logout What our Clients say

i-p-tel.com work WERY hard

I and want to make a good |y
product, Thatis exactly the

reason I have contributed in

the ways that I have, These
guys not only read the forums

they reply!

Search Wiki » supernettel, Puerto Vallarta

Search Forum »

PayPal
PREMIUM ACCOUNT | zovere | | g
|@| https: |/ fwww, pbxes,comfconfig, phprdisplay=8 l_ ’_ ’_ l_ ’—g & Internst
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/A= p - b - xes: your virtual PBX and CRM on demand - Microsoft Internet Explorer == x|
File Edit Wiew Favorites Took  Help ‘ ;,'
% LY . L . i, 5
@ Back ~ () - |_L| \ELI ) | P ) Search . Favorkes _‘} ‘ = ] - _J ﬁ 5
Address I@ https: w0, phies . comjcanfig.phprdisplay=8 j Go | Links >
¥ HIN{ GPoups Provider recommendation for -

WARNING: Tou have not defined a general outbound route! business
® TS 06/07/2007
» Incoming Calls Full .725 support

Route Name: I\/D\F'mute TR0y
Inbound Routing PBXes PRO -- Multichannal
. Customer Interaction
Outbound Routing Route Password: 02/25/2007
Cther languages
» Add Route Extension: I —
Statistics

¥

»

0On Hold Music

Custamers

» System Recordings Dial Patterns Accounts 12,528
- Phones 17,485

» General Settings . :I Datacenters

» Personal Data : Frankfure SR
Hiirnberg 50.2%

» Call Monitor San Diegoe 8.2%
Mew York 10.8%

» Status Paris 15,7%

-
» Support —I What our Clients say

Clean & Remove duplicates |

Logout i-p-tel.com work YERY hard

’ = and want to make 1 good
Dial rules wizards | (pick one) = product, That is ensctly the

reason [ have contributed in

the ways that I have, These
guys not only read the forums
they reply!

I .I supernettel, Puerto Yallarta

Search Wiki »

Search Forum » Trunk Sequence

Add PayPal

PREMIUM ACCOUNT Submit Changes |

ORDER NOW »
MORE DETAILS »

GET YOUR PRO

ORDER NOW »
MORE DETAILS »

=l
GED B T —

Enter a name of this route in ‘Route Name’.

In ‘Dial patterns’ decide which calls are to be directed to this route, e.g.:
0. - calls to numbers starting with O

00. - calls to numbers starting with 00

XX. - all external calls

Optionally you can set a password for this route (in this case the route will prompt
users for a password before allowing calls to progress).
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* b - % es  your virtual PBX and CRM on demand - Microsoft Internet Explorer ;Iilll
Fle Edit ¥iew Favortes Tools Help | ",’
e Back - LJ - \ﬂ @ _b ‘ /__j Search ‘in‘\'( Favarites {‘3 | <] = :ﬁ .J_".I A _J ﬁ ﬁ
Address I@ https:{jwnnl . pheces. comyfconfig. php?display=8 j o ‘ Links *
7 RINg GFoUps Frovider recommendation for -
» Trunks WARNING: vou have not defined a general outbound route! gléj??ejsstD?

» Incoming Calls Full 3.72% support
. Route Mame: “olFroute 03/01/2007
» Inbound Routing PB¥es PRO -- Multichannel
R Customer Interaction
Outbound Routing Route Passward: 02/25/2007
3 Add Route Extension: I— Other languages
Statistics

On Hold Music

Customers

» System Recordings Dial Patterns Accounts 12,528

. Phones 17.485
»
General Settings . ;I DI e

» Personal Data : ZIATG 1515
Hiirnberg 50.2%

» Call Monitor San Diego 2.2%
Hew York 10,8%

» Status Paris 15.7%

-
» Support —I What our Clients say
» Logout Elaan & Remove duplicates | i-p-tel.cam work VERY hard

- and want to make a good
Disl rules wizards | (pick one) = product, That is sxactly the

reason [ have contributed in

the ways that I have These
Search Forum » quys not only read the forums
they reply!

SIP#voipdiscount vI supernettel, Puerto Wallarta

Search Wiki » 2dd PayPa,‘]
PREMIUM ACCOUNT Submit Changes |

ORDER NOW »
MORE DETAILS »

Trunk Sequence

GET YOUR P-B-XF5pRo

ORDER NOW ¥
MORE DETAILS »

=l
&Tons T T a—

In “Trunk Sequence’ section pick a trunk and press ‘Add’.

Submit the changes. New outbound route appears in ‘Outbound Routing’ tab.
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To apply the changes press the red bar.

File Edit Wiew Favorites Tools  Help

=18]x]

| .:'r

@Back - \) - Iﬂ @ \-_;j | /i__\:' Search \Er\\'rFavorites €}|

Address I@ https: [ funanan. phxes. cormfcanfig.php

— TOUR FERZOHAL FHOMEEOXES COMMUNITY SETUP

» Setup > Cutbound Routin

» Setup PBXes
» Extensions
» Ring Groups

» Trunks

Route Mame: I
Route Password: I
Extension: I

Dial Patterns

» Incoming Calls
» Inbound Routing
» Outbound Routing
» Add Route
* 0 ¥YoIProute
» On Hold Music =l

» System Recordings

» General Settings

» Personal Data ;I
» Call Monitor Clean & Remove duplicates |
» Status . g A

Dial rules wizards I(plck one) 'l
#» Support
» Logout

Trunk Sequence

——

Search Forum »

Search Wiki » Submit Changes |

I j'

Add

SHOP

I Bs0 ks

ippbx01  LOGOUT »

3 CREATE ¥ OUR ACCOUNT

0272007
Handoff between WLAN/GSM
networks

07/27/2007

Prowider recommendation for
business

0&/07/2007

Full 5,729 suppart
05/01/2007

PBHes PRO -- Multichannel
Customer Interaction

02/25/2007

Crther languages
Statistics

Customers

Acoounts 12,528
Phanes 17.485
Diatacenters

Frankfurt 15.1%
Miitnberg 50.2%
San Diego 8.2%
Mew Yark 10.5%
Paris 15.7%

What our Clients say

i-p-tel.com werk WERY hard
and want to make 2 good
product, That is enactly the
reasen I have contributed in
the ways that I have, Thasa
gquys not only read the farums
they reply!

supernettel, Puerto Wallarta

PayPal

COMATE

=

N Y
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7. Configuration of Incoming Calls and Inbound Routing

To get inbound calls working properly, you need to configure Incoming Calls
and Inbound Routing.

7.1 Incoming Calls

Open ‘Incoming Calls’ tab.

&= p b - x es : your virtual PBX and CRM on demand - Microsoft Internet Explorer == =]
File Edit Wiew Favorikes Tools  Help | :.-'
\ " — e ) =
Qs - O - (%] [B] 0| POseeth §oraeis @) (27 2 - | B
Address I@ hittps:}fwwwl, pbxes,comfconfig.phprdisplay=9 j G0 | Links >
-
» Home » Setup » Incoming Calls News

Setup PBXes
Docurmenting features for the

» Extensions Wiki

» Ring Groups Handoff between WLAN/GSM

» Trunks regular hours: times |7:56-17:05 days |morii networks

» Incoming Calls Prouider recammendation for
business

» Inbound Routing & Digital Receptionist: x
Full 729 rt

% Outbound Routing @ Extension: |John <3333> 7| £ B

. . Ij PBXes PR -~ Multichannel
» On Hold Music 7 Ring Group: |# T Customer Interaction
» System Recordings C queue: | [T Statistics

General Settings

after hours: Accounts 12,724
» Personal Data S T
» Call Monitor
o SREnms " Digital Receptionist: E ;’;Al;r:; ;gg:
" Extension: [John <3333> 'I San Diego 8.3%
® SUppEH: ' Hew Yark 11.0%
» Logout & Ring Group: Iﬁﬂ :I' Paris 15.7%
' Queue: E What our Clients say

l— i-p-tel.com work VERY hard
q o o and want to make 1 good
Override Incoming Calls Settings product. That is eHagcdv B
reason I have contributed in
the ways that I have, These
l— ' no averride (obey the above settings) quys not only read the forums
1
 farce regular hours they reply!

Search Wiki » 1
' farce after hours supernettel, Puerto Yallarta

PayPal
PREMIUM ACCOUNT it Chanaes
ORDER NDW »

MORE DETAILS »

Search Forum »

GET YOUR PRO =~
[E1pzre T e leeme

Pick an Extension/Ring Group (or Digital Receptionist/Queue available with Premium
Account) that should answer incoming calls.

Submit the changes and apply them by pressing the red bar.
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7.2 Inbound Routing

Open ‘Inbound Routing’ tab.

&= p b - x es : your virtual PBX and CRM on demand - Microsoft Internet Explorer — =] x|
File Edit Wiew Favorites Tools  Help | :,'
5 " — e ) =
eﬁack M > lj |§| _,I\J ‘ 7 ! Search . Favorites @3‘ T R _ﬂ - gl ﬁ 3
Address I@ hittps: s, phies comjconfia.phprdisplay=7 j Go | Links **
-
> Home » Setup » Inbound Routin News
» Setup PBXes
H Docurmenting features for the
*» Exrtensions Wiki
» Ring Groups Handoff hetween WLAN/GSM
» Trunks Add Incoming Route networks
» Incoming Calls Erou\derrecommendationFor
usiness

Inbound Routing

: Full 729 rt
» Add Incoming Route ALY IVUIPU‘SCUUHT u suppal
Outbound Routing Caller ID Murnber: I z?f;smilj?n;;rl\:iitincnhannal

On Hold Music

Statistics
» System Recordings Options
» General Settings Qﬁ:::;ts ifgi;
» Personal Data o= -
. rankfurt i
» Call Monitor Privacy Manager: |No ¥ Miirnberg 49,39
San Diego 8.3%
» Status L Hew York 11.0%
» Support Set Destination Paris 15.7%
» Logout What our Clients say

©n 3 finsl note, I've gt to
) I = applaud PBXas: I'm 2 newbis

. ] & Extension: | John <3333~ with litele enperiznce, but

 Ring Group: |#1 'I they've certainly got a great

Search Forum » system here, It's not only

 Callthru pIN-I simple for beginners, but it
) also offers programming

flexibility for the more
aduanced. Fantastic.., Wielen | =
Search Wiki » Subrnit Dank fiter Eure tolle
—'ﬁ Leistung!
702220, Odense
PREMIUM ACCOUNT

ORDER NOW »
MORE DETAILS »

PayPal

DONATE

=1
@ I O =Y X S

‘Trunk’ - Define the expected trunk on incoming calls
‘Set Destination’ - Pick an Extension/Ring Group (or Digital Receptionist/Queue -

available with Premium Account) that should answer incoming calls.

Attention!!! If you leave the ‘Trunk’ field blank, incoming calls from all trunks

will be routed to this Extension/Ring Group.

Submit the changes and apply them by pressing the red bar.
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8. Making calls

Making calls from iSoftPhone is easy! Just enter the number to dial and hit

<ENTER> or press - button. Below was shown sample call process for dialed
number 99.

iSaftPhone ©
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Once the connection is established then iSoftPhone display’s will look like shown

below.

iSoftPhone ®

Call established

To finish the connection just hit <ESC> or press - button. Once the connection is

finished then iSoftPhone display’s will look like shown below.
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iSoftPhone

Call hangup

9. Verification steps

The following steps can be used to verify and/or troubleshoot installations in
the field.
1. Check your iSoftPhone 1.4 version. Required build is 1.4040-070912 or
higher.
2. Configure internal subscriber (Extension) on pbxes.com iPPABX for the
iISoftPhone. After configuring the iSoftPhone, verify that the “Logged in...”
message appears in the upper left corner of the display, indicating that

registration has occurred.
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a]

3. Verify that the extension shown in the brackets (in our example <ippbx01-
3333> is the desired value.

4. If “Not logged to server.” is displayed,

iSoftPhone ®

Mot logged to server.

use the following to troubleshoot the problem: Check in Preferences “My SIP
accounts” settings if the correct IP address of pbxes.com iPPABX is entered. If
“Connecting...” is displayed for a long time
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iSoftPhone ®
Connecting.

pbxes.org

= Am BT
O

please check that username and password is correct entered for this account
in Preferences “My SIP accounts”.

5. Verify basic feature by making calls to other phones. If audio cannot be heard
from an iSoftPhone, check the firewall/NAT settings to make sure that ports for

VolP communication are not blocked.
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10. Support

For technical support of iSoftPhone please contact:

Internet: http://www.call4dmac.com/isoftphone/support.html

E-mail: mac support@xdsnet.de
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